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previous Outlook versions

Executive summary

Microsoft Corporation (Microsoft) commissioned
Principled Technologies (PT) to determine whether
Outlook 2007 SP2 is more responsive than Outlook

2007 SP1. To do so, we measured the time to conduct

a set of real-world email tasks and run some typical
user workflows. We found Outlook 2007 SP2 was
noticeably more responsive to user input and actions
than the earlier version and took less time to perform
the standard operations.

We tested three versions of Microsoft Office Outlook:
e Outlook 2003 SP3
e Outlook 2007 SP1
e Outlook 2007 SP2

We measured how responsive each Outlook version

was when performing a set of common email tasks. We

ran these tests on two systems:

KEY FINDINGS

o Outlook 2007 SP2 was notably faster (26

percent) than Outlook 2007 SP1 on a set of
common email tasks and was even faster (35
percent) with larger mailboxes. (See Figure 1.)

Users will experience considerable
responsiveness and speed improvements with
Outlook 2007 SP2 on such common day-to-day
operations as launching, synchronizing, and
searching, particularly with large mailboxes.

(See Test results.)

Outlook 2007 SP2 delivered some of these
performance improvements in part by reducing
writes to the hard drive by as much as 62
percent vs. Outlook 2007 SP1 and 82 percent
vs. Outlook 2003. (See Figures 16 and 17.)

e Dell OptiPlex 755 with Intel Core 2 Duo E4500 2.2 GHz (desktop)
e Lenovo ThinkPad T61 with Intel Core 2 Duo T7100 1.8 GHz (notebook)

The results in this report are the averages of the results for the desktop and notebook systems. (For detailed
information on these systems and the Microsoft Exchange server we used, see Appendix A.) We conducted all

tests with two mailbox sizes: 250 MB and 5 GB.
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Figure 1: Average system response time, in seconds, to complete a set of common email tasks for
three Outlook versions with 250MB and 5GB mailbox sizes. Smaller numbers, reflecting quicker

response times, are better.

In Appendix B, we list
these tasks and
provide the results for
each Outlook version
running with the two
mailbox sizes.

As Figure 1 shows,
with the smaller
mailbox, Outlook 2007
SP2 completed the
tasks in 7.1 seconds,
26 percent less time
than Outlook 2007
SP1’s 9.6 seconds,
and 8 percent more
time than Outlook
2003 SP3'’s 6.6
seconds. With the
larger mailbox,
Outlook 2007 SP2
completed the tasks in
6.6 seconds, 35




percent less time than Outlook 2007 SP1’s 10.2 seconds, and 1 percent more time than Outlook 2003 SP3’s 6.5
seconds.

We tested each Outlook version running with both mailbox sizes on a set of common email tasks including
launching Outlook, creating messages and meeting requests, replying to email, switching folder arrangements,
and closing Outlook.

Launching Outlook

Microsoft introduced the To-Do Bar, a feature that is on by default, with Outlook 2007. Because having the To-Do
Bar on increases the time to launch Outlook, we timed this operation two ways: with the To-Do Bar on, and with it
off.

Outlook 2003 does not have a To-Do Bar. The Outlook 2003 feature that most closely approximates the To-Do
Bar is Task view; however, the two features are very different. Task view, which is an alternative to the Inbox
view, presents only a list of tasks the user has entered into Outlook 2003. By contrast, when Outlook 2007
launches with the To-Do Bar on, it presents a view of a list of tasks the user has entered (the To-Do list), the
calendar with its associated appointments, and the Inbox.

With To-Do Bar off and the smaller mailbox, Outlook 2007 SP2 launched 52 percent faster than Outlook 2007
SP1, and 67 percent slower than Outlook 2003 SP3; with To-Do Bar off and the larger mailbox, Outlook 2007 SP2
launched 61 percent faster than Outlook 2007 SP1, and 30 percent slower than Outlook 2003 SP3.

With the smaller mailbox, launching Outlook 2007 SP1 with the To-Do Bar on was 340 percent slower than
Outlook 2003 SP3 in Task view. With the To-Do Bar on, Outlook 2007 SP2 launched 113 percent slower than
Outlook 2003 SP3. Turning the To-Do Bar off reduced that margin to 252 percent for Outlook 2007 SP1, and 67
percent for Outlook 2007 SP2.

With the larger mailbox, turning the To-Do Bar off reduced the percentage loss to Outlook 2003 SP3 from 277
percent for Outlook 2007 SP1 down to 230 percent and from 118 percent down to 30 percent for Outlook 2007
SP2.

We present our launch Outlook results with Task View or To-Do Bar off in Figure 2 and on in Figure 13.

Closing Outlook

We timed how long it took Outlook to close after synchronization tasks were complete. With the smaller mailbox,
Outlook 2007 SP2 closed 2 percent faster than Outlook 2007 SP1 and 4 percent faster than Outlook 2003 SP3;
with the larger mailbox, Outlook 2007 SP2 closed 21 percent faster than Outlook 2007 SP1 and 31 percent slower
than Outlook 2003 SP3. We present these results in Figure 12.

Additional operations
We timed additional operations in each Outlook version running with both mailbox sizes. These included the
following:

synchronizing (time for a new OST to completely download)

searching for 200 or fewer message results in a single folder
searching for thousands of message results in a single folder
searching for thousands of message results in all mail folders

With the smaller mailbox, Outlook 2007 SP2 synchronized a new OST (an offline folder in Outlook) download 14
percent faster than Outlook 2007 SP1; with the larger mailbox, Outlook 2007 SP2 synchronized a new OST
download 34 percent faster than Outlook 2007 SP1. We present these results in Figures 14 and 15.

During the synchronization test, we measured the number of total reads and writes to the disk. With the smaller
mailbox, Outlook 2007 SP2 produced 46 percent fewer writes to the hard drive than Outlook 2007 SP1 and 65
percent fewer writes than Outlook 2003. With the larger mailbox, Outlook 2007 SP2 produced 62 percent fewer
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writes than Outlook 2007 SP1 and 82 percent fewer writes than Outlook 2003. We present these results in
Figures 16 and 17.

With the smaller mailbox, Outlook 2007 SP2 required 65 percent fewer reads from the hard drive than Outlook
2007 SP1 and 96 percent fewer reads than Outlook 2003. With the larger mailbox, Outlook 2007 SP2 required 5
percent more reads than Outlook 2007 SP1 and 97 percent fewer reads than Outlook 2003. We present these
results in Figures 18 and 19.

With the smaller mailbox, Outlook 2007 SP1 performed searches for messages from 79 to 85 percent faster than
Outlook 2003 SP3, and Outlook 2007 SP2 performed searches for messages from 46 to 82 percent faster than
Outlook 2003. With the larger mailbox, the improvement of both Outlook 2007 SP1 and SP2 over Outlook 2003
remained consistent at 96 to 100 percent. We present these results in Figures 20 through 25.

We provide more details of these tests in our Test results section, and list all test results for each version of
Outlook running with both mailbox sizes in Appendix B.

Test results

Common email tasks

Launch Outlook with Task View or To-Do Bar off

Figure 2 shows the average system response time to launch Outlook with Task View or To-Do Bar off. We
consider Outlook to have launched when the reading pane is visible and message text appears.

With the smaller

Figure 2: Average system response time, in minutes:seconds, to launch Outlook with Task View or

To-Do Bar off. Smaller numbers, reflecting quicker response times, are better.

Launch Outlook with Task View or ToDo Bar off glglzlblg)tjngr:]eﬂél)?rf 12 %g7
00:00.5 Average response time seconds, 52.4 percent
less time than Outlook
00:04.0 2007 SP1, which took
- 00:03.5 O 250MB mailbox Outlook 3.54 SecondS, and
e 2003 SP3 67.4 percent more
o  00:03.0 B 250MB mailbox Outlook time than Outlook
9 2007 SP1 2003 SP3, which took
#  00:025 B 250MB mailbox Outlook 101 ’ (‘;" I?N' ﬁoh
& Loozo 2007 SP2 .01 seconds. ith the
3 o 0 5GB mailbox Outlook larger mailbox,
£ 00:015 1 2003 SP3 Outlook 2007 SP2
S 00010 - B 5GB mailbox Outlook launched in 1.60
o 2007 SP1 seconds, 60.5 percent
£ 00005 { B 5GB mailbox Outlook less time than Outlook
- 2007 SP2 2007 SP1, which took
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1.23 seconds.
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Launch reply to email while synchronizing
Figure 3 shows the average system response time to launch a reply to email while synchronizing.
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Figure 3: Average system response time, in minutes:seconds, to launch a reply to email while
synchronizing. Smaller numbers, reflecting quicker response times, are better.

percent less time than Outlook 2003 SP3, which took 0.57 seconds.

Launch reply to email after synchronization is complete
Figure 4 shows the average system response time to launch a reply to email after synchronization is complete.
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Figure 4: Average system response time, in minutes:seconds, to launch a reply to email after
synchronization is complete. Smaller numbers, reflecting quicker response times, are better.

With the smaller
mailbox, Outlook
2007 SP2 launched a
reply to email while
synchronizing in 0.69
seconds, 29.8
percent less time
than Outlook 2007
SP1, which took 0.99
seconds, and 5.8
percent less time
than Outlook 2003
SP3, which took 0.74
seconds. With the
larger mailbox,
Outlook 2007 SP2
launched a reply to
email while
synchronizing in 0.43
seconds, 2.1 percent
less time than
Outlook 2007 SP1,
which took 0.43
seconds, and 25.7

With the smaller
mailbox, Outlook
2007 SP2 launched a
reply to email after
synchronization is
complete in 0.51
seconds, 8.9 percent
less time than
Outlook 2007 SP1,
which took 0.56
seconds, and 9.3
percent less time than
Outlook 2003 SP3,
which took 0.57
seconds. With the
larger mailbox,
Outlook 2007 SP2
launched a reply to
email after
synchronization is
complete in 0.35
seconds, 31.3
percent less time than
Outlook 2007 SP1,

which took 0.51 seconds, and 19.0 percent less time than Outlook 2003 SP3, which took 0.44 seconds.
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Launch new email while synchronizing
Figure 5 shows the average system response time to launch a new email while synchronizing.
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Figure 5: Average system response time, in minutes:seconds, to launch a new email while
synchronizing. Smaller numbers, reflecting quicker response times, are better.

Outlook 2003 SP3, which took 0.55 seconds.

Launch new email after synchronization is complete
Figure 6 shows the average system response time to launch a new email after synchronization is complete.
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Figure 6: Average system response time, in minutes:seconds, to launch a new email after
synchronization is complete. Smaller numbers, reflecting quicker response times, are better.

0.39 seconds.

With the smaller
mailbox, Outlook
2007 SP2 launched a
new email while
synchronizing in 0.56
seconds, 20.6
percent less time than
Outlook 2007 SP1,
which took 0.71
seconds, and 12.5
percent less time than
Outlook 2003 SP3,
which took 0.64
seconds. With the
larger mailbox,
Outlook 2007 SP2
launched a new email
while synchronizing in
0.37 seconds, 4.4
percent less time than
Outlook 2007 SP1,
which took 0.39
seconds, and 32.2
percent less time than

With the smaller
mailbox, Outlook 2007
SP2 launched a new
email after
synchronization is
complete in 0.46
seconds, 9.9 percent
less time than Outlook
2007 SP1, which took
0.51 seconds, and 2.1
percent less time than
Outlook 2003 SP3,
which took 0.47
seconds. With the
larger mailbox,
Outlook 2007 SP2
launched a new email
after synchronization
is complete in 0.28
seconds, 28.7 percent
less time than both
Outlook 2007 SP1 and
Outlook 2003 SP3,
both of which took
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Launch new meeting request
Figure 7 shows the average system response time to launch a new meeting request.
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Figure 7: Average system response time, in minutes:seconds, to launch a new meeting request.
Smaller numbers, reflecting quicker response times, are better.

which took 0.49 seconds.

Switch folder to Conversation arrangement
Figure 8 shows the average system response time to switch the folder to Conversation arrangement.
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Figure 8: Average system response time, in minutes:seconds, to switch the folder to Conversation
arrangement. Smaller numbers, reflecting quicker response times, are better.

seconds, and 28.4 percent less time than Outlook 2003 SP3, which took 0.58 seconds.

With the smaller
mailbox, Outlook
2007 SP2 launched a
new meeting request
in 0.44 seconds, 12.2
percent less time than
Outlook 2007 SP1,
which took 0.50
seconds, and 4.5
percent more time
than Outlook 2003
SP3, which took 0.42
seconds. With the
larger mailbox,
Outlook 2007 SP2
launched a new
meeting request in
0.46 seconds, 8.8
percent less time than
Outlook 2007 SP1,
which took 0.50
seconds, and 6.8
percent less time than
Outlook 2003 SP3,

With the smaller
mailbox, Outlook
2007 SP2 switched
the folder to
Conversation
arrangement in 0.34
seconds, 1.7 percent
less time than
Outlook 2007 SP1,
which took 0.35
seconds, and 3.7
percent less time
than Outlook 2003
SP3, which took 0.36
seconds. With the
larger mailbox,
Outlook 2007 SP2
switched the folder to
Conversation
arrangement in 0.41
seconds, 7.5 percent
more time than
Outlook 2007 SP1,
which took 0.39
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Switch folder to Date arrangement
Figure 9 shows the average system response time to switch the folder to Date arrangement.
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Figure 9: Average system response time, in minutes:seconds, to switch the folder to Date
arrangement. Smaller numbers, reflecting quicker response times, are better.

Outlook 2003 SP3, which took 0.27 seconds.

Switch folder to From arrangement
Figure 10 shows the average system response time to switch the folder to From arrangement.
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Figure 10: Average system response time, in minutes:seconds, to switch the folder to From
arrangement. Smaller numbers, reflecting quicker response times, are better.

Outlook 2003 SP3, which took 0.25 seconds.

With the smaller
mailbox, Outlook
2007 SP2 switched
the folder to Date
arrangement in 0.32
seconds, 8.0 percent
less time than
Outlook 2007 SP1,
which took 0.34
seconds, and 12.7
percent more time
than Outlook 2003
SP3, which took 0.28
seconds. With the
larger mailbox,
Outlook 2007 SP2
switched the folder to
Date arrangement in
0.26 seconds, 26.5
percent less time than
Outlook 2007 SP1,
which took 0.35
seconds, and 3.7
percent less time than

With the smaller
mailbox, Outlook
2007 SP2 switched
the folder to From
arrangement in 0.32
seconds, 1.2 percent
less time than
Outlook 2007 SP1,
which took 0.33
seconds, and 3.9
percent more time
than Outlook 2003
SP3, which took 0.31
seconds. With the
larger mailbox,
Outlook 2007 SP2
switched the folder to
From arrangement in
0.21 seconds, 33.1
percent less time than
Outlook 2007 SP1,
which took 0.31
seconds, and 14.6
percent less time than

Principled Technologies, Inc.: Responsiveness of Outlook 2007 SP2 vs. previous Outlook versions 7



Switch folder to Calendar arrangement
Figure 11 shows the average system response time to switch the folder to Calendar arrangement.
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Figure 11: Average system response time, in minutes:seconds, to switch the folder to Calendar
arrangement. Smaller numbers, reflecting quicker response times, are better.

seconds.

Close after synchronization is complete
Figure 12 shows the average system response time to close Outlook after synchronization is complete.
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Figure 12: Average system response time, in minutes:seconds, to close Outlook after synchronization

is complete. Smaller numbers, reflecting quicker response times, are better.

percent more time than Outlook 2003 SP3, which took 1.49 seconds.

With the smaller
mailbox, Outlook
2007 SP2 switched
the folder to Calendar
arrangement in 0.39
seconds, 5.4 percent
more time than both
Outlook 2007 SP1
and Outlook 2003
SP3, both of which
took 0.37 seconds.
With the larger
mailbox, Outlook
2007 SP2 switched
the folder to Calendar
arrangement in 0.30
seconds, 20.8
percent less time than
Outlook 2007 SP1,
which took 0.38
seconds, and 7.8
percent more time
than Outlook 2003
SP3, which took 0.28

With the smaller
mailbox, Outlook
2007 SP2 closed
after synchronization
was complete in 1.35
seconds, 1.8 percent
less time than
Outlook 2007 SP1,
which took 1.37
seconds, and 4.3
percent less time
than Outlook 2003
SP3, which took 1.41
seconds. With the
larger mailbox,
Outlook 2007 SP2
closed after
synchronization was
complete in 1.96
seconds, 20.7
percent less time
than Outlook 2007
SP1, which took 2.47
seconds, and 31.2
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Additional operations

Launch Outlook with Task View or To-Do Bar on
Figure 13 shows the average system response time to launch Outlook with Task View or To-Do Bar on. We
consider Outlook 2007 to have launched when the reading pane of the Inbox with the message text appears, and
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Figure 13: Average system response time, in minutes:seconds, to launch Outlook with Task View or To-

Do Bar on. Smaller numbers, reflecting quicker response times, are better.

the To-Do Bar is
visible with task list,
the calendar date
picker, and the
calendar. We
consider Outlook
2003 to have
launched when the
single Task View
with the task list
appears. For
Outlook 2007,
Microsoft added the
To-Do Bar feature,
which shows daily
tasks, appointments,
and a calendar. The
To-Do Bar is not
present in Outlook
2003.

With the smaller
mailbox, Outlook
2007 SP2 launched

in 1.81 seconds, 51.7 percent less time than Outlook 2007 SP1, which took 3.73 seconds, and 112.6 percent
more time than Outlook 2003 SP3, which took 0.85 seconds. With the larger mailbox, Outlook 2007 SP2 launched
in 2.65 seconds, 42.3 percent less time than Outlook 2007 SP1, which took 4.59 seconds, and 117.5 percent

more time than Outlook 2003 SP3, which took 1.22 seconds.
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Synchronization time for new OST to completely download (250MB mailbox)
Figure 14 shows the average system response time to synchronize the complete download of a new OST in each
version of Outlook with the smaller mailbox.
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Figure 14: Average system response time, in minutes:seconds, to synchronize the complete download
of a new OST with a 250MB mailbox. Smaller numbers, reflecting quicker response times, are better.

Synchronization time for new OST to completely download (5GB mailbox)
Figure 15 shows the average system response time to synchronize the complete download of a new OST in each
version of Outlook with the larger mailbox.
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Figure 15: Average system response time, in minutes:seconds, to synchronize the complete download

of a new OST with a 5GB mailbox. Smaller numbers, reflecting quicker response times, are better.

With the smaller
mailbox, Outlook
2007 SP2
synchronized the
complete download
of anew OST in 1
minute and 21.92
seconds, 13.8
percent less time
than Outlook 2007
SP1, which took 1
minute and 35.03
seconds, and 35.4
percent less time
than Outlook 2003
SP3, which took 2
minutes and 6.76
seconds.

With the larger
mailbox, Outlook
2007 SP2
synchronized the
complete download
of a new OST in 29
minutes and 35.79
seconds, 33.6
percent less time
than Outlook 2007
SP1, which took 44
minutes and 36.27
seconds, and 27.9
percent less time
than Outlook 2003
SP3, which took 41
minutes and 2.40
seconds.
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Average number of disk writes during synchronization (250MB mailbox)
Figure 16 shows the average number of total disk writes during synchronization with the smaller mailbox. Lower

numbers are better.

14,000
(2]

£ 12,000
3

2 10,000 -
0

T

o 8,000 -
o

3

g 6,000 -
£

2 4,000 A
(]

= 2,000 1
)

>

< 0 -

Average number of disk writes during synchronization
(250MB mailbox)

0 250MB mailbox Outlook
2003 SP3

@ 250MB mailbox Outlook
2007 SP1

B 250MB mailbox Outlook
2007 SP2

Figure 16: Average number of disk writes during synchronization with a 250MB mailbox. Lower

numbers are better.

Average number of disk writes during synchronization (5GB mailbox)
Figure 17 shows the average number of total disk writes during synchronization with the larger mailbox. Lower

numbers are better.
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Figure 17: Average number of disk writes during synchronization with a 5GB mailbox. Lower numbers

are better.

With the smaller
mailbox, Outlook
2007 SP2 produced
4,018 disk writes
during
synchronization, 46.1
percent less than
Outlook 2007 SP1,
which produced
7,454 disk writes,
and 65.3 percent
less than Outlook
2003 SP3, which
produced 11,593
disk writes.

With the larger
mailbox, Outlook
2007 SP2 produced
104,979 disk writes
during
synchronization, 61.7
percent less than
Outlook 2007 SP1,
which produced
273,835 disk writes,
and 82.2 percent less
than Outlook 2003
SP3, which produced
590,304 disk writes.
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Search for a message (200 or fewer, single folder) (250MB mailbox)
Figure 20 shows the average system response time to search for a message among 200 or fewer, within a single
folder, in each version of Outlook with the smaller mailbox.
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Figure 20: Average system response time, in minutes:seconds, to search for a message among 200 or
less in a single folder, with a 250MB mailbox. Smaller numbers, reflecting quicker response times, are

better.

Search for a message (200 or fewer, single folder) (5GB mailbox)
Figure 21 shows the average system response time to search for a message among 200 or fewer, within a single
folder, in each version of Outlook with the larger mailbox.
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Figure 21: Average system response time, in minutes:seconds, to search for a message among 200 or
less in a single folder, with a 5GB mailbox. Smaller numbers, reflecting quicker response times, are

better.

With the smaller
mailbox, Outlook
2007 SP2 searched
for a message
among 200 or fewer,
within a single folder,
in 0.84 seconds, the
same amount of time
as Outlook 2007
SP1. Both of these
took 81.7 percent
less time than
Outlook 2003 SP3,
which took 4.59
seconds.

With the larger
mailbox, Outlook
2007 SP2 searched
for a message
among 200 or fewer,
within a single
folder, in 0.89
seconds, 28.6
percent less time
than Outlook 2007
SP1, which took
1.25 seconds, and
97.1 percent less
time than Outlook
2003 SP3, which
took 30.58 seconds.

Principled Technologies, Inc.: Responsiveness of Outlook 2007 SP2 vs. previous Outlook versions 12



Search for a message (thousands of results, single folder) (250MB mailbox)
Figure 22 shows the average system response time to search for a message among thousands of results, within
a single folder, in each version of Outlook with the smaller mailbox.

00:04.00
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0 250MB mailbox Outlook
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2007 SP1
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Figure 22: Average system response time, in minutes:seconds, to search for a message among
thousands of results in a single folder, with a 5GB mailbox. Smaller numbers, reflecting quicker
response times, are better.

Search for a message (thousands of results, single folder) (5GB mailbox)
Figure 23 shows the average system response time to search for a message among thousands of results, within
a single folder, in each version of Outlook with the larger mailbox.
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Time in minutes:seconds
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00:08.00 H
00:06.00 f
00:04.00 1
00:02.00 -
00:00.00 -

O5GB mailbox Outlook
2003 SP3

B 5GB mailbox Outlook
2007 SP1

B 5GB mailbox Outlook
2007 SP2

Figure 23: Average system response time, in minutes:seconds, to search for a message among
thousands of results in a single folder, with a 5GB mailbox. Smaller numbers, reflecting quicker
response times, are better.

With the smaller
mailbox, Outlook
2007 SP2 searched
for a message
among thousands
of results, within a
single folder, in 0.83
seconds, 4.8
percent more time
than Outlook 2007
SP1, which took
0.80 seconds, and
78.0 percent less
time than Outlook
2003 SP3, which
took 3.78 seconds.

With the larger
mailbox, Outlook
2007 SP2 searched
for a message
among thousands
of results, within a
single folder, in 0.92
seconds, 2.8
percent more time
than Outlook 2007
SP1, which took
0.90 seconds, and
96.9 percent less
time than Outlook
2003 SP3, which
took 29.63 seconds.

Principled Technologies, Inc.: Responsiveness of Outlook 2007 SP2 vs. previous Outlook versions 13



Search for a message (thousands of results, all mail items) (250MB mailbox)
Figure 24 shows the average system response time to search for a message among thousands of results, within
all mail items, in each version of Outlook with the smaller mailbox.
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Figure 24: Average system response time, in minutes:seconds, to search for a message among
thousands of results in all mail items, with a 250MB mailbox. Smaller numbers, reflecting quicker
response times, are better.

Search for a message (thousands of results, all mail items) (5GB mailbox)
Figure 25 shows the average system response time to search for a message among thousands of results, within
all mail items, in each version of Outlook with the larger mailbox.
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Figure 25: Average system response time, in minutes:seconds, to search for a message among
thousands of results in all mail items, with a 5GB mailbox. Smaller numbers, reflecting quicker
response times, are better.

With the smaller
mailbox, Outlook
2007 SP2 searched
for a message
among thousands of
results, within all
mail items, in 3.02
seconds, 259.6
percent more time
than Outlook 2007
SP1, which took
0.84 seconds, and
45.9 percent less
time than Outlook
2003 SP3, which
took 5.59 seconds.

With the larger
mailbox, Outlook
2007 SP2 searched
for a message
among thousands of
results, within all
mail items, in 4.36
seconds, 320.4
percent more time
than Outlook 2007
SP1, which took
1.04 seconds, and
98.5 percent less
time than Outlook
2003 SP3, which
took 4 minutes and
53.48 seconds.
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Workflow tests

In this section, we present response times for a series of 79 common tasks from a typical workday, which we
explain in the Test methodology section. Because Step 1, launching Outlook and synchronizing the mailbox,
takes a significant amount of time on the larger mailbox, we break this step out.

Figure 27 shows
Workflow the average

Average system response time system response

01:45 time on the 79-

__ step workflow test.

The average

01:15 system response

[11] Step 2-79: time for the

01:00 Remainder of workflow

00:45 workflow decreased with

each version of
00:30 [ Step 1: Launch Outlook.

Outlook and sync
mailbox With the smaller
00:00 +—" mailbox, Outlook
OutlookOutlook/Outlook/OutlookOutlookOutlook 2007 SP2

2003 | 2007 | 2007 | 2003 | 2007 | 2007 completed the

SP3 | SP1 | SP2 | SP3 | SP1 | SP2 total workflow in
17 percent less
250MB mailbox 5GB mailbox time than Outlook
2007 SP1 and 36
percent less time
Figure 27: Average system response time, in hours:minutes, of three Outlook versions with two mailbox than Outlook 2003
sizes for the 79-step workflow test. Smaller numbers, reflecting quicker response times, are better. SP3. With the

larger mailbox,

Outlook 2007 SP2 completed the total workflow in 23 percent less time than Outlook 2007 SP1 and 47 percent
less time than Outlook 2003 SP3.

01:30

00:15 A mn

Time in hours:minutes

Test methodology
This section outlines the tests PT conducted to compare the performance of Outlook 2003 SP3, Outlook 2007
Outlook 2007 SP1, and Outlook 2007 Outlook 2007 SP2.

Installing and configuring the mail server

To set up this server, you must install several software components. The following subsections detail the
necessary installation processes. Before following these instructions, make sure to statically assign an IP address
for the server under test, and then plug that port into another system or router. This allows the server to correctly
add the domain server function. We recommend making the IP address 192.168.1.250.

Installing and setting up the operating system

Install Microsoft Windows Server 2008, Enterprise x64 Edition.

Finish the installation procedure using default settings.

Right-click the desktop, and select Personalize.

Click the Screen Saver link.

Click the Screen saver drop-down menu, and select (None).

Click Apply.

Click Change power settings.

Under Balanced, click Change plan settings.

Change the Turn off monitor drop-down menu to Never.

10 Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.
11. Open the Start menu, type regedit in the search field, and press Enter.

CENOITRAWN =
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12. To allow the server to automatically log into the OS after a system reboot, change the Registry key
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon] to have the
following values:

DefaultPassword=Password1
AutoAdminLogon=1
DefaultUsername=administrator

13. Restart the server.

Installing the domain controller
Set a static IP address using the following steps:

1.

PoO0T®
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h.

Right-click the network icon in the quick-launch bar, and choose Network and Sharing Center.
Click Manage network connections.

Right-click the local area connection, and click Properties.

Select Internet Protocol Version (TCP/IPv4), and click Properties.

Select the Use the following IP address radio button, and type 192.168.0.250 in the IP
address field.

Press Tab to auto-fill 255.255.255.0 in the Subnet mask field.

In the Preferred DNS server field, type 127.0.0.1 and click OK to close the IPv4 properties
window.

Click Close.

2. Give the computer a name:

«Q@

~@Poo0TD

Click Start, right-click Computer, and select Properties.

Click Change Settings.

Click Change.

Type mailserver in the Computer name field, and click OK.

In the Computer Name/Domain Changes pop-up window, click OK.
Click OK.

In the Microsoft pop-up window, click Restart Now.

3. Promote the mailserver to domain controller:
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g.

Select Start>Command Prompt.

Type dcpromo

At the Welcome pop-up window, click Next.

At the Operating System Compatibility screen, click Next.

At the Choose a Deployment Configuration screen, select the Create a new domain in a new
forest radio button, and click Next.

At the Name the Forest Root Domain screen, type a domain name (i.e., mailserver.com), and
click Next.

At the Set Forest Functional Level screen, choose Windows Server 2008 from the drop-down
menu, and click Next.

At the Additional Domain Controller Options screen, accept the defaults, and click Next.

When the Static IP assignment window pops up, click Yes, the computer will use a dynamically
assigned IP address.

When the Active Directory domain Services Installation Wizard window pops up, click Yes.

At the Location for Database, Log Files, and SYSVOL screen, accept the defaults. Click Next.
At the Directory Services Restore Mode Administrator Password screen, enter a password, and
click Next.

At the Summary screen, review the selections, and click Next.

When the installation software prompts you to do so, insert the OS CD, and click OK.

At the Completing the Active Directory Installation Wizard screen, click Finish.

When the system prompts you to reboot the server, click Restart Now.

After the server reboots, log into the system.

Installing Internet Information Services 6.0
Select Start->Administrative Tools—>Server Manager.
2. On the left side bar, click Roles.

1.
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9.
10.

In the right frame, click Add Roles.

At the Select Server Roles screen, click Web Server (lIS).

In the Add features required for Web Server (1IS) pop-up window, click Add Required Features.

Click Next.

At the Web Server (l1S) screen, click Next.

At the Select Role Services screen, select the 1IS 6 Metabase Compatibility, IS 6 Management Console,
Basic Authentication, Windows Authentication, Digest Authentication, and Dynamic content Compression
checkboxes, and click Next.

At the Confirm Installation Selections screen, click Install.

At the Installation Results screen, click Close

Installing Exchange Server 2007

1.
2.
3.

Insert the Microsoft Exchange Server 2007 SP1 CD.

In the AutoPlay pop-up window, click Run Setup.EXE.

Click Step 3: Install Microsoft Windows PowerShell. Note: The installer should have steps 1 and 2 grayed
out because it considers them complete. Select Start>Command Prompt.

In the Command Prompt window, type ServerManagerCmd —I PowerShell and press Enter.

When the installation completes, close the Command Prompt window.

Click the link to Step 4: Install Microsoft Exchange Server 2007 SP1.

Click Next to go past the introduction screen.

Accept the license agreement, and click Next.

Select No for error reporting, and click Next.

. Select Typical Exchange Server Installation, and click Next.

. Leave the organization name at default (First Organization), and click Next.

. Select Yes to the question about client computers running Outlook 2003 and earlier, and click Next.
. If a warning about a lack of SMTP appears after the check finishes, ignore it.

. Click Install to start the installation process.

. Once installation is complete, click Finish. Exchange should automatically open the Exchange

Management Console.

. Click the link to Step 5: Get critical updates for Microsoft Exchange.

. Click Accept the license agreement.

. Click Install.

. When the install is complete, close Internet Explorer.

. Run Windows Update, and download all available updates through 02/26/2009.

Configuring Exchange Server 2007

1.
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13.
14.
15.

If Exchange does not automatically open the Exchange Management Console, select Start>All
Programs->Microsoft Exchange Server 2007->Exchange Management Console.

In the left pane, expand Organization Configuration, and select Hub Transport.

In the action pane on the far right, select New Send Connector.

Name the send connector SMTP, select the intended use as Internet, and then click Next.

In the Address space window, click Add.

In the SMTP Address Space window, put * as the address, make sure a check appears beside Include all
subdomains, and click OK.

Click Next.

Accept defaults for the next two pages by clicking Next.

At the New Connector page, click New to create the connector.

. Click Finish to close the New SMTP Send Connector wizard.
. In the left pane of the Exchange Management Console window, expand Server Configuration, and select

Mailbox.

. In the Database Management tab, right-click First Storage Group, and select New Public Folder

Database.

Name the new public folder database Public Folder Database and click New.

In the Completion page, click Finish to close the New Public Folder Database window.
Close the Exchange Management Console, and reboot the server.
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16.

17.

18.
19.

20.
21.
22.
23.
24.
25.
26.

27.

28.
20.

30.
31.
32.
33.
34.

35.
36.

37.
38.
39.
40.
41.
42.
43.
44.
45.
46.
47.
48.
49.
50.
51.
52.
53.
54.
55.

Once the server successfully reboots, log in, and select Start->All Programs-> Administrative
Tools—>Active Directory Users and Computers.

In the Active Directory Users and Computers window, select mailserver.com in the left pane, and open
Users in the right pane.

Right-click a blank area in the Users folder, and select New—>User.

In the New Object — User window, complete the name fields as you wish (we used first name: test, last
name: tester, logon name: tester), and select Next.

Enter a secure password (we used “Password1”), and check Password never expires.

In the information pop-up window, click Accept.

Select Next to confirm.

Click Finish to close the New Object — User window.

Double-click the new user to bring up the Properties window.

Under the Member Of tab, click Add.

In the Enter the object names to select dialog box, type Domain Admins; Exchange Organization
Administrators, select Check Names to verify, and click OK.

Click OK to close the user Properties window, and then close the Active Directory Users and Computers
window.

Select Start-> All Programs—-> Microsoft Exchange Server 2007->Exchange Management Console.

In the left pane of the Exchange Management Console window, select Recipient Configuration, and in the
right pane, select New Mailbox.

In the New Mailbox window, select User Mailbox, and click Next.

In the User Type page, select Existing users, and click Add.

Select the new account you created earlier, and click OK to add it to the selection box.

Click Next.

In the Mailbox Settings page, leave the Alias textbox with default settings, and select Browse in the
Mailbox database selection spot.

In the Select Mailbox database window, select Mailbox Database, and click OK.

Click through the next screens to create the new mailbox, and click Finish to close the mailbox and save
your changes when you have done so.

Close the Exchange Management Console.

Select Start->All Programs—>Microsoft Exchange Server 2007->Exchange Management Console.

In the left windowpane, expand Server Configuration and Mailbox so the First Storage Group is visible.
Right-click First Storage Group, and select Properties.

Check the Enable circular logging box.

Click Apply.

Right-click Mailbox Database under First Storage Group, and select Properties.

Check the box beside This database can be overwritten by a restore.

Click Customize beside Maintenance interval.

Remove all blue from the boxes so the system will not perform maintenance, and click OK.

Click the Limits tab, and uncheck Issue warning at, Prohibit send at, Prohibit send, and Receive at.

At the Mailbox Database Properties window, click Apply.

Click OK to close the Mailbox Database Properties window.

Right-click Public folder Database under Second Storage Group, and select Properties.

Check the box beside This database can be overwritten by a restore.

Click Customize beside Maintenance interval.

Remove all blue from the boxes so the system will not perform maintenance, and click OK.

At the Public Folder Database Properties window, click Apply.

Click OK to close the Public Folder Database Properties window.

Capturing the base test image

We used Symantec’s Ghost product to capture a sector image of the hard disk to an external USB hard drive.
Each time we ran a test on a machine, we used the Ghost image to return that machine to the above
configuration. After re-imaging, we installed the software necessary to run each test and rebooted. We followed
this process to capture the image.

1.

Insert a bootable Ghost CD.
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Power off the computer.

Attach the secondary hard disk.

Power on the computer.

At the Symantec Ghost screen, click OK.

Select Options—>Image/Tape tab—->Image All->Accept.
Select Local->Disk->To Image.

Click OK.

Select the Primary disk, and click OK.

Installing and configuring the client system

To get the most accurate and repeatable results possible, start with a clean hard disk, and set up all the test
systems using the following procedures. This test does not attempt to account for every possible post-installation
customization an end user could choose to perform. To compare the products with as similar settings as possible,
change the settings so all products index as much as possible the same set of data.

Installing Microsoft Windows Vista Enterprise with Service Pack 1

During installation of the operating system, connect the computers to the production network to download
Windows updates, drivers, and Office 2007 updates. Use the following process to install and configure a clean
version of Windows Vista Enterprise on each system:

Install Windows Vista Enterprise:

1.
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Boot to a Windows Vista Enterprise DVD.

When the installer prompts you to do so, press any key to boot from CD or DVD.
At the Language and preference screen, accept the default options, and click Next.
Click Install now.

Check | accept the license terms.

Click Next.

At the Which type of installation do you want? screen, select Custom (advanced).
Click Drive options (advanced).

Select the destination disk for the operating system.

Click Format.

At the All data stored will be permanently deleted dialog, click OK.

Once the system finishes formatting the disk, click Next.

. Fill in the Username field, and click Next.

Fill in the Computer name field, and click Next.

When the option to enable Automatic Updates appears, click Ask me later.

Select the correct time zone, date, and time; and click Next.

At the Select your computer’s current location screen, click Work location.

At the Thank you screen, click Start.

When the Windows Vista Enterprise with Service Pack 1 installation completes, close the Welcome
Center Dialog.

At the Set network location screen, click Work location.

Click Close.

ét the test resolution:

Right-click the desktop.

Select Personalize.

Click Display Settings.

Set the resolution to the maximum supported resolution.
Click OK.

. Select the secondary hard disk in the copy image to drop-down box, name the file BASE and click Save.
. At the Compress Image dialog, select High.

. At the Proceed dialog, select Yes.

. When the ghost image is complete, click OK, and exit Ghost.

. Power off the computer.

. Remove the secondary hard disk.

. Reboot the computer.
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3. Verify that Windows Automatic Updates are off:
Click Start>All Programs->Windows Updates.
Click Change settings, located in the left panel.
Select Never check for updates and Include recommended updates.
Click OK.
Click Get updates for more products.
In the Microsoft Update window that opens, select | accept the Terms of Use, and click Install.
Click Security.
Under Security Center, select Turn automatic updating off.
Select the Never check for updates radio button.
Click OK.
4, Set the Power Management settings:
Click Start->Control Panel.
Select Appearance and Personalization.
Under Personalization, click Change screen saver.
Select None from the Screen saver drop-down menu.
In the Screen Saver Settings dialog box, click Change power settings.
Click Change plan settings.
From the Turn off the display and Put the computer to sleep drop-down menus, select Never.
Click Save changes.
Close the Power Options window.
On the Screen Saver Settings, click OK.
Close the Appearance and Personalization window.
|sable system notifications:
Click Start.
Select Control Panel.
Click Security.
Select Security Center.
Select Change the way Security Center alerts me from the left panel.
Select Don’t notify me and don’t display the icon.
Close the Windows Security Center window.
Close the Security window.
sable User Account Control (UAC):
Click Start.
Select Control Panel.
Click User Accounts.
In the main window, click Turn User Account Control on or off.
. Uncheck Use User Account Control (UAC) to help protect your computer.
Click OK.
Click Restart Now.
7. Run Windows Update, and download all available updates through 02/26/2009.
8. Capture the Base test image as we describe in the Capturing the base test image section above.
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Installing Microsoft Office 2003

Insert the Microsoft Office 2003 installation DVD.

At the AutoPlay dialog box, click Run SETUP.exe.

Enter your CD key, and click Next.

Accept defaults for user info by clicking Next.

Click I accept the terms in the License Agreement, and click Next.
Accept defaults for installation type and path by clicking Next.
Click Install to continue with installation.

Once installation is complete, click Finish.

If the installer prompts you to do so, reboot the system.

10 Run the update for SP3.

11. Click Yes to install the update.

CENOITRAWON =
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12.
13.
14.
15.

Click Yes to accept the License Agreement.

If the installer prompts you to shut down applications to complete installation, click OK.

Once you have successfully installed the update, click Yes to reboot the system.

Run Windows Update, and install all recommended and critical updates for Office 2003 through
02/26/2009, rebooting if required.

Setting up Microsoft Outlook 2003

1.

Connect to the mail server using a static IP address:
Ensure that you have plugged in both the client and the mail server into the same network.
Click Start->Network.
Click Network and Sharing Center.
Click Manage network connections.
Right-click Local Area Connection, and click Properties.
Double-click Internet Protocol Version 4 (TCP/IPv4) to open the Properties window.
Click the Use the following IP address radio button.
In the IP address field, type 192.168.0.251
Press Tab to automatically complete the Subnet mask field with 255.255.255.0
In the Default gateway and Preferred DNS server fields, type 192.168.0.250
Leave the Alternate DNS server field blank, and click OK.
In the Local Area Connection Properties window, click OK.
. If the installer prompts you to Set Network Location, select Work, and click Close.
n. Close all related windows.
Open Control Panel->User Accounts—>Mail.
Click Add...
Type exchange and click OK.
Click Next to add a new account.
Select Microsoft Exchange Server, and click Next.
Type mailserver.com in the Microsoft Exchange Server box.
Uncheck Use Cached Exchange Mode.
Type Test Tester into the User Name box, and click Check Name.
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. Type tester for the user name and Password1 for the password, and click OK.

. Click Next.

. Click Finish to complete the account setup.

. Close Mail Setup.

. Launch Outlook: Start->Email.

. Type Passwordl for the password, and check Remember Password.

. Close Outlook.

. Capture the Outlook 2003 base image as we describe in the Capturing the base test image section

above.

Installing Microsoft Office Outlook 2007

1.
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Insert the Microsoft Office 2007 installation DVD.

At the AutoPlay dialog box, click Run SETUP.EXE.

Click Install Now.

At the conclusion of installation, close the Internet Explorer window, and close the Microsoft Office
Enterprise 2007 window.

Run the update for SP1.

Click the check box to accept the License Agreement, and click Continue.

Click Yes to reboot the system.

Run Windows Update, and install all recommended and critical updates for Office 2007 through
02/26/2009, rebooting if required.

Setting up Microsoft Outlook 2007

1.

Connect to the mail server using a static IP address:
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Ensure that you have plugged both the client and the mail server into the same network.
Click Start->Network.
Click Network and Sharing Center.
Click Manage network connections.
Right-click Local Area Connection or Wireless Network Connection, and click Properties.
Double-click Internet Protocol Version 4 (TCP/IPv4) to open the Properties window.
Click the Use the following IP address radio button.
In the IP address field, type 192.168.0.251
Press Tab to automatically complete the Subnet mask field with 255.255.255.0
In the Default gateway and Preferred DNS server fields, type 192.168.0.250
Leave the Alternate DNS server field blank, and click OK.
In the Local Area Connection Properties window, click OK.
. If the installer prompts you to Set Network Location, select Work, and click Close.
n. Close all related windows.
Open Control Panel, and open Mail.
Click Add...
Type exchange and click OK.
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Check the checkbox beside Manually configure server settings or additional service types, and click Next.

Select the Microsoft Exchange radio button, and click Next.

Type mailserver.com in the Microsoft Exchange Server box.
Uncheck the box beside Use Cached Exchange Mode.

Type Test Tester into the User Name box, and click Check Name.

. Type tester for the user name and Password1l for the password, and click OK.

. Click Next.

. At the Congratulations box, click Finish.

. Click OK to close the Mail window.

. Launch Outlook: Start->Email.

. Type Password1l for the password, and check Save password.

. At the setup RSS Feeds dialog, click No.

. Uncheck the box beside Search Microsoft Office Online for Help content when I'm connected to the

Internet, and click OK.

. Close Outlook.
. Capture the Outlook 2007 base image as we describe in the Capturing the base test image section

above.

Setting up the Exchange Server mail database

Reset the client system to the Outlook 2003 SP3 base image.

Copy the 250 MB PST file to the client system.

Launch Outlook: Start->Email.

Ensure that the client connects to the server by pressing F9 (Send/Receive).
Go to File=>Import and Export...

Click Next.

Scroll through the list, select Personal Folder File (PST), and click Next
Click Browse, and navigate to the test PST file. Select it, and click Open.
Click Next.

. Click Finish to Import the test mailbox database.

. Once the database is complete, dismiss any reminders, and verify by pressing Yes.
. Allow the mailbox to sync with the Exchange Server.

. Capture the Exchange Server with 250MB mail database image.

. Repeat these steps with a duplicate Exchange Server using a 5GB mailbox and a clean client system.

Setting up and indexing the mailbox on the client

1.
2.

Reset the client system to the Outlook 2003 SP3 base image.
Launch Outlook: Start->Email.
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8.
9.
10.
11.

Connect the client system to the 250MB Exchange Server.

Ensure that the client connects to the server by pressing F9 (Send/Receive).

Allow for the creation of the OST file on the test system.

Open the Indexing Options control panel, and wait until Windows Vista completes indexing the system.
Capture the fully indexed Outlook 2003 SP3 test image as we describe in the Capturing the base test
image section above.

Capture the Exchange Server image.

Reset the client system to the Outlook 2007 SP1 base image, and repeat steps 1 through 7.

Reset the client system to the Outlook 2007 SP2 base image, and repeat steps 1 through 7.

Repeat steps 1 through 10, connecting the system to the 5GB Exchange Server.

Setting up and running a trace with the Windows Performance Toolkit 4.1.1 (WPT)

1.

2.
3.
4

©oo~NoO

10.
11.
12.
13.
14.
15.
16.
17.

18.
19.
20.
21.
22.
23.
24.

Reset the system to the base test image.
Download the WPT from http://msdn.microsoft.com/en-us/performance/default.aspx.
Install the Windows Performance Toolkit using the Complete option.
Perform the following steps to turn on the correct providers in the trace:
a. Open an elevated command prompt:
i. Press the Windows key.
ii. Type cmd in the Start Search field.
iii. Press Ctl+Shift+Enter.
b. Type xperf.exe -on base+cswitch+fileio+networktrace inthe elevated command
prompt window to start the trace.
Run test in Outlook.
Exit Outlook.
Stop the trace by typing xperf .exe -stop in the command prompt.

Launch Xperfview: Start->Programs—->Microsoft Windows Performance Toolkit->Performance Analyzer.

Perform the following steps to open the trace using Xperfview:
a. Select Trace from the list of menu items.
b. Select Open.
c. Browse to locate the kernel.etl file at the root of c:
d. Click Open.
Right-click Disk 1/O graph.
Select Select View.
Right-click Disk 1/0O graph/chart again.
Select Summary Table.
Drag Path Name and Process to the left of the yellow line, if they are not already there.
Find the row with outlookOST.
Copy and paste the row into Excel by selecting it and typing ct1+C>Ct1+V
Verify the following columns are present:
e Read counts
e Read size
e Write counts
e  Write size
Right-click Providerlds graph.
Select Select View.
Right-click Providerlds graph/chart again.
Select Summary Table.
Drag Path Name and Process to the left of the yellow line, if they are not already there.
Copy and paste the tcpip row into Excel by selecting it and typing Ct1+C>Ct1+V
Copy and paste the udpip row into Excel by selecting it and typing cCt1+C>Ct1+V

Running the tests
We conducted two main groups of tests: individual or atomic tests, and workflow tests. Before we ran the
individual tests, we reset the system with the test image, and we ran the individual tests a total of seven times.
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We considered the first two runs conditioning runs, and dropped them. We took the average of the last five hand-
timed results. We ran these tests as individual units. We captured disk I/O and network traffic measurements on
three of the individual tests.

We ran the workflow tests as a set of tasks or actions that a typical user performs in the course of a workday. We
performed the actions listed, in order, as quickly as a typical user would perform them, hand-timed the entire
process, and measured disk I/0 and network traffic over the course of the entire workflow. Before each run of the
workflow tests, we reset the system with the test image, and we ran the tests.

Individual tests

This section details a set of individual test runs. We ran each test seven times. We collected the last five results.
These steps apply to both Office 2003 and Office 2007, unless we note otherwise. These tests require an initial
reset of the system image and OST file. Each system has six base system images, one each with Outlook 2003
SP3 using the 250MB mailbox, Outlook 2003 SP3 using the 5GB mailbox, Outlook 2007 SP1 using the 250MB
mailbox, Outlook 2007 SP1 using the 5GB mailbox, Outlook 2007 SP2 using the 250MB mailbox, and Outlook
2007 SP2 using the 5GB mailbox.

1. Reset the client system to the fully indexed Outlook 2003 SP3 image.
2. Reset the server to the OL03_mailboxsize_client image.
3. Launch Outlook with To-Do Bar on.
a. For Outlook 2003 (Note: Outlook 2003 does not have a To-Do Bar. To set the Tasks view on,
do the following):
i. Tools>Options>Other tab-> Advanced Options.
ii. Change “Startup in this folder:” to Tasks by clicking Browse, scrolling down to Tasks,
and clicking OK.
iii. Close Outlook 2003.
iv. Start the WPT trace as we describe in Setting up and running a trace with the Windows
Performance Toolkit 4.1.1.
v. Click Start.
vi. From the Start menu, simultaneously click Email and start the timer.
vii. Stop the timer when Outlook completes loading.
viii. Stop the trace.
ix. Repeat steps 3a-iv through 3a-viii six times, and record the last five results, renaming
kernel.etl to OL.03 _mailboxsize client ToDoON RUNn.etl after each run.
X. At the conclusion of the seventh run, close the To-Do Bar by clicking the X to prepare
for the next test.
b. For Outlook 2007:
i. Startthe WPT trace as we describe in Setting up and running a trace with the Windows
Performance Toolkit 4.1.1.
ii. Click Start.
iii. From the Start menu, simultaneously click Email and start the timer.
iv. Stop the timer when Outlook completes loading.
v. Stop the trace.
vi. Repeat steps 3a-i through 3a-v six times, and record the last five results, renaming
kernel.etl to OL.07 mailboxsize client ToDoON RUNn.etl after each run.
vii. At the conclusion of the seventh run, close the To-Do Bar to prepare for the next test.
4. Launch Outlook with To-Do Bar off:
a. Start the WPT trace as we describe in Setting up and running a trace with the Windows
Performance Toolkit 4.1.1.
Click Start.
From the Start menu, simultaneously click Email and start the timer.
Stop the timer when Outlook completes loading.
Stop the trace.
Repeat steps 4a through 4e six times, and record the last five results, renaming kernel.etl to
OL03 mailboxsize client ToDoOFF RUNn.etl after each run.

~ooo00o
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5. FolderSwitch to Conversation arrangement:

b
c.
d.
e

e .

Launch Outlook if it is not already open.

Select View—>Arrange By from the menu.

Simultaneously choose Conversation and start the timer.

Stop the timer when the FolderSwitch completes.

Select View—->Arrange By->From from the menu.

Repeat steps 5a through 5e six times, and record the last five results.

6. FolderSwitch to Date arrangement:

"‘.‘D oo0ooco

Launch Outlook if it is not already open.

Select View—>Arrange By from the menu.

Simultaneously choose Date and start the timer.

Stop the timer when the FolderSwitch completes.

Select View>Arrange By->From from the menu.

Repeat steps 6a through 6e six times, and record the last five results.

7. FoIderSW|tch to From arrangement:

"‘FD.Q-.OP'S”

Launch Outlook if it is not already open.

Select View—>Arrange By from the menu.

Simultaneously choose From and start the timer.

Stop the timer when the FolderSwitch completes.

Select View>Arrange By->Date from the menu.

Repeat steps 7a through 7e six times, and record the last five results.

8. FoIderSW|tch to Calendar:

a.
b.
c.
d.
e.

Launch Outlook if it is not already open.

Simultaneously press Ctrl+2 and start the timer.

Stop the timer when the calendar appears.

Switch back to mail view (Ctrl+1).

Repeat steps 8a through 8d six times, and record the last five results.

9. Click Reply (while synchronizing):

SQ@ ™0 Qo0 T

Close Outlook.

Delete the local OST file on the client found at C:\Users\User\Appdata\Local\Microsoft\Outlook.

Launch Outlook, and allow it to start to synchronize.

Select an email.

Simultaneously click Reply and start the timer.

Stop the timer when the reply completes opening.

Repeat steps 9a through 9f six times, and record the last five results.
Allow Outlook to finish updating all folders in preparation for the next test.

10. Click Reply (after synchronization is complete):

a.
b.
c.
d.
e.

Launch Outlook if it is not already open.

Select an email.

Simultaneously click Reply and start the timer.

Stop the timer when the reply completes opening.

Repeat steps 10a through 10d six times, and record the last five results.

11. Click New (while synchronizing):

@*0a0T®

Close Outlook.

Delete the local OST file on the client found at C:\Users\User\Appdata\Local\Microsoft\Outlook.

Launch Outlook, and allow it to start to synchronize.

Simultaneously click New and start the timer.

Stop the timer when the new email message completes opening.

Repeat steps 11a through 11e six times, and record the last five results.
Allow Outlook to finish updating all folders in preparation for the next test.

12. Click New (after synchronization is complete):

a.
b.
c.
d.

Launch Outlook if it is not already open.

Simultaneously click New and start the timer.

Stop the timer when the new email message completes opening.
Repeat steps 12a through 12c six times, and record the last five results.
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13. New meeting request:
a. Launch Outlook if it is not already open.
b. Simultaneously press Ctrl+Shift+Q and start the timer.
c. Stop the timer when the new meeting request completes opening.
d. Repeat steps 13a through 13c six times, and record the last five results.
14. Search for a message (200 or less - single folder):
a. Launch Outlook if it is not already open.
b. Select the first folder under Inbox.
e For Outlook 2003:
i. Press Ctrl+E to open the Find tool.
ii. Type London into the Look for field.
iii. Simultaneously click Find Now and start the timer.
iv. Stop the timer when search completes. (Note: When Outlook 2003 begins a search, a
search icon appears to the left of the Look for field. When Outlook 2003 finishes a
search, the icon disappears.)
v. Clear the results.
vi. Repeat steps i through v six times, and record the last five results.
e For Outlook 2007:
i. Simultaneously type London into the Search field and start the timer. (Note: This may
require a second person on the timer to account for word wheeling.)
ii. Stop the timer when the search completes.
iii. Clear the results.
iv. Repeat steps i to iii six times, and record the last five results.
15. Search for a message (thousands of results - single folder):
a. Launch Outlook if it is not already open.
b. Select the folder named Active.
e For Outlook 2003:
i. Press Ctrl+E to open the Find tool.
i. Type Workplan into the Look for field.
iii. Simultaneously click Find Now and start the timer.
iv. Stop the timer when search completes. (Note: When Outlook 2003 begins a search, a
search icon appears to the left of the Look for field. When Outlook 2003 finishes a
search, the icon disappears.)
v. Repeat steps i through iv six times, and record the last five results.
e For Outlook 2007:
i. By default, Office 2007 limits search results to no more than 200 items. To remove this
limit, use the following steps:
a. Click the drop-down menu next to the Search field.
b. Click Search Options...
c. Uncheck the box beside Make searches faster by limiting the number of results
shown, and click OK.
ii. Simultaneously type Workplan into the search field and start the timer. (Note: This
may require a second person on the timer to account for word wheeling.)
iii. Stop the timer when the search completes.
iv. Repeat steps i to ii six times, and record the last five results.
16. Search for a message (thousands of results - All Mail ltems):
a. Launch Outlook if it is not already open.
e For Outlook 2003:
i. Press Ctrl+E to open the find tool.
ii. Click the Search In drop-down menu.
iii. Select Search All Mail ltems.
iv. Type Workplan into the Look for field.
v. Simultaneously click Find Now and start the timer.
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vi. Stop the timer when the search completes. (Note: When Outlook 2003 begins a
search, a search icon appears to the left of the Look for field. When Outlook 2003
finishes a search, the icon disappears.)

vii. Repeat steps i through vi six times, and record the last five results.

e For Outlook 2007:

i. Click All Mail Items under Mail Folders on the left-hand side of the screen.

. Simultaneously type Workplan into the Search All Mail ltems field and start the
timer. (Note: This may require a second person on the timer to account for word
wheeling.)

iii.  Stop the timer when the search completes.

iv. Repeat steps i through iv six times, and record the last five results.

17. Synchronization time for new OST to completely download:
a. Close Outlook.
b. Delete the local OST file on the client found at C:\Users\User\Appdata\Local\Microsoft\Outlook.
c. Startthe WPT trace as we describe in Setting up and running a trace with the Windows
Performance Toolkit 4.1.1.
d. Simultaneously launch Outlook and start the timer.
e. Stop the trace, and the timer when synchronization completes, as indicated by the all folders
are up to date status message.
f. Repeat steps 17a to 17f six times, and record the last five results, renaming kernel.etl to
OL03_mailboxsize_client_ OSTsync_RUNn.etl after each run.
g. Close Outlook.
18. Close Outlook (after synchronization is complete):
a. Launch Outlook, and allow it to start to synchronize by waiting 30 seconds.
b. Close Outlook: Simultaneously close Outlook and start the timer.
Stop the timer when the Outlook window disappears.
Wait for 5 minutes.
e. Repeat steps 19a to 19d six times, and record the last five results.
19. Copy trace results off the computer from the root of C:\
20. Reset the client and server with the paired Outlook 2007 SP1 images, and repeat steps 3 through 19.
21. Reset the client and server with the paired Outlook 2007 SP2 images, and repeat steps 3 through 19.

oo

Workflow tests

This section details running a set of workflow tests. We ran each set of workflow tests a total of three times.
Before each full run, we reset both the client system and the Exchange Server to their respective unindexed, base
test image. (Note: indexing the 250MB mailbox takes over 30 minutes. Indexing the 5GB mailbox takes several
hours. We stopped timing during the indexing process. We also stopped the trace.) These steps apply to both
Office 2003 and Office 2007, unless we note otherwise.

Note: The workflow tests assume that the Reading Pane is on and visible in the right panel. We had one system
not under test connected to the test network for the purpose of sending email messages, and sending/receiving
meeting requests.

1. Reset the server with the Outlook 2003 SP3 250MB test image, and the system with the base Outlook
2003 SP3 image.

Connect it to the Exchange Server.

Launch Outlook: Start>Email.

Set Cached mode to on (Accounts—>Microsoft Exchange—>Check Use Cached Exchange Mode).
Close Outlook.

Start the WPT trace as we describe in the Setting up and running a trace with the Windows Performance
Toolkit 4.1.1 (WPT) section.

Start the timer.

Launch Outlook: Start>Email.

Allow Outlook to fully synchronize the mailbox.

O If the reminder dialog box appears with three appointments, click Dismiss All.

oA WN
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11.
. If this is a 5GB mailbox database:

13.
14.
15.

16.
17.

18.
19.
20.

21.
22.

23.

24.
25.
26.
27.
28.

29.
. Select the 15th email, and click the flag button located in to the right of the date.
31.
32.
33.
34.
35.
. Pause for around 2 seconds while reading the email message, and then close the message.
37.

38.
39.
40.

41.
42.

43.

Stop the timer and the trace.

a. Collect the .ETL file that the trace created in the Windows Performance Toolkit folder to a thumb
drive.
b. Restart the system, and restore the fully indexed image.
c. Skip the next step.
Open the Indexing Options control panel, and wait until the system completes indexing.
Launch Outlook: Start->Email.
Create five new tasks by pressing CTRL+SHIFT+K to open the new task dialog, typing New Task as the
subject, and clicking Save and Close. You must do this five times.
Close Outlook.
Start the WPT trace as we describe in the Setting up and running a trace with the Windows Performance
Toolkit 4.1.1 (WPT) section.
Start the timer.
Launch Outlook: Start->Email.
Perform an incremental synchronization of 20 email messages:
a. Click the Connected to Microsoft Exchange status message in the lower right corner of Outlook.
b. Select Work offline.
c. Send 20 messages to Test Tester from a third system.
d. Click the Offline status message, and deselect Work offline.
Read the first five emails, remaining on each email for around 2 seconds.
Select the second and third email, and delete both by right-clicking the two selected emails and choosing
Delete.
Select the fourth email (now the second in order because Outlook deleted two emails in step 22), and
click the Reply button located in the toolbar.
Type This is a test as the reply, and click Send.
Select the first email, and click the Reply button located in the toolbar.
Type This is a test as the reply, and click Send.
Select the first email, and click the Forward button located in the toolbar.
Type Test2 Tester inthe To... field, type I have already replied to this email in the email
body, and click Send.
Select the eighth email, and click the flag button located to the right of the date.

Select the first folder, and select the third email message in that folder.

Pause for around 2 seconds while reading the email message in preview pane.
Select the eighth email in the first folder.

Pause for around 2 seconds while reading the email message in preview pane.
Select the second folder, and double-click the ninth email message in that folder.

Double-click the 10th email message in the second folder, pause for around 2 seconds while reading the
email message, and then close the message.
Select the first five email messages in the inbox, and move these messages to the first folder by dragging
and dropping them.
Select the first six email messages in the inbox folder, and move these messages to the second folder by
dragging and dropping them.
Select the Inbox, and arrange the email messages by conversation: View—>Arrange By-> Conversation.
Arrange the email messages in the inbox by from: View—>Arrange By—->From.
Select the first five email messages from the first user and categorize them:
e For Outlook 2003:
i. Right-click the selected email messages, and select Categorize.
ii. Select the Business check box in the Categories dialog box, and click OK.
e For Outlook 2007:
i. Right-click the selected email messages, and select Categorize.
ii. Select Red Category from the list of choices.
Create a new folder, and name it User2
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44.

45.
46.

47.
48.
49.
50.
51.

52.
53.

54.

55.

a. Right-click the Inbox, and select New Folder.

b. Type User2 into the Create New Folder dialog box, and click OK.
Select the first 10 email messages from Jessica Tester in the inbox, and move them to the folder you
recently created and named User2 by dragging and dropping.
Arrange the email messages in the inbox by date: View—>Arrange By->Date.
Mark the first 10 email messages as unread by right-clicking the selected email messages, and selecting
Mark as Unread.
Send three meeting requests from the non-tested system to the system under test.
Click Dismiss all on the test machine, and click Yes to dismiss.
Right-click each new request, and click Accept.
Read the first 10 email messages from Test2 Tester in Preview Pane:

a. Select each email in sequence.

b. Pause for around 2 seconds to simulate reading each in the Reading Pane.
Select the sixth message you just read, click Reply in the toolbar, type That’s okay as a response,
click the Save button to save a draft of the message, and close the response without sending it.
Switch to the calendar by pressing Ctrl+2.
Switch to full-week view by clicking the Week button in Outlook 2003, and the Show full week radio button
in Outlook 2007.
Switch to week view by clicking the Work week button in the Outlook 2003 toolbar, and clicking the Week
button in Outlook 2007.
Create an appointment on Wednesday:

e For Outlook 2003:

i. Double-click Wednesday, 9:00AM.

Type Doctor in the Subject field.
Click the Save and Close button.

e For Outlook 2007:

i.

i.

iii.

Create a New Meeting request:

56.

Place the mouse cursor over Wednesday, 9:00AM.
Click once in that time slot, and type Doctor
Press Enter.

e For Outlook 2003:

Open the drop-down menu associated with the New button in the toolbar, and select
Meeting Request.

Type Test2 Tester in the To... field.

Type Meet ing in the Subject field.

Click Recurrence, and select 10:00 AM as the Start time and 11:30 AM as the End time.
v. Select Weekly from the options in the Recurrence pattern section, and click OK.
vi. Set the Reminder to 30 minutes, and click Send.

e For Outlook 2007:

Open the drop-down menu associated with the New button in the toolbar, and select
Meeting Request.

Type Test2 Tester in the To... field.

Type Meeting in the Subject field.

Click Recurrence, and select 10:00 AM as the Start time and 11:30 AM as the End time.
v. Select Weekly from the options in the Recurrence pattern section, and click OK.
vi. Setthe Reminder to 30 minutes, click Send, and click Yes when Outlook prompts you

about not providing a location.

57. Create the following appointments:
e For Outlook 2003:

i

ii.
iii.
iv.
V.

Double-click the grey area below the word Thursday.
Type 211 day in the Subject field.

Click the Save and Close button.

Double-click 2:00 PM Friday.

Type Meeting 1 in the Subject field.
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58.
59.

60.
61.
62.

63.
64.

65.

vi. Setthe End time to 4:00 PM.
vii. Click the Save and Close button.
viii. Double-click 11:00 PM Friday.
ix. Type Overnight trip inthe Subject field.
Xx. Set the End time to 9:00 AM.
xi. Click the Save and Close button.
xii. Double-click 10:00 AM Thursday.
xiii. Type Meeting 2 in the Subiject field.
xiv. Set the End time to 11:00 AM.
xv. Click the Save and Close button.

e For Outlook 2007:

Place the cursor over the blue area below the word Thursday.
Click To add event, and type A11 day.
Press Enter.

iv. Place the cursor over 2:00 PM Friday.
v. Click to add event, type Meeting 1 in the time field, and press Enter.
vi. Drag the end time to 4:00 PM.
vii. Place the cursor over 11:00 PM Friday.
viii. Type Overnight trip inthe time field, and press Enter.
ix. Drag the end time to 8:00 AM.
x. Place the cursor over 8:00 AM Saturday.
xi. Click to add event, type Meeting 2 in the time field, and press Enter.
xii. Drag the end time to 11:00 AM.

Switch back to inbox by pressing Ctrl+1.
Double-click message 12, and flag it for Follow-up tomorrow:
e For Outlook 2003:

Click the flag button in the toolbar.
Select the following day’s date for the Due by: selection.
Click OK.

e For Outlook 2007:

Click the flag button in the toolbar.
Select tomorrow from the drop-down menu.
Close the email message.

Double-click message 13, forward it to Test2 Tester, and close the message.

Arrange the email messages in the inbox by conversation: View—->ArrangeBy->Conversation.

Delete the fourth and fifth conversations by right-clicking the conversation, choosing Delete, and clicking
Yes to delete.

Arrange the email messages in the inbox by date: View—>ArrangeBy—-> Date.
Mark five items as completed:
e For Outlook 2003:
i. Click Tasks.
ii. Double-click each item one at a time, change the status to Completed, and click Save
and Close.

e For Outlook 2007:
i. Select five items listed in the To-Do Bar.
ii. Right-click those items, and select Mark Complete from the list of choices (or Follow
up~>Mark Complete).
Add a new task for today:
e For Outlook 2003:
i. Click Tasks.
ii. Right-click anywhere in the Tasks section, and select New Task.
iii. TypeNew task for today inthe Subject, and click Save and Close.
e For Outlook 2007:
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66.

67.
68.
69.
70.
71.
72.
73.
74.

75.

76.

83.
84.
85.
86.
87.
88.
89.

i.  With the To-Do Bar open, right-click anywhere in the lower section of the To-Do Bar, and
select New Task.
ii. TypeNew task for today inthe Subject, and click Save and Close.
Search for the word workplan in Folder1:
e For Outlook 2003:
i. Select Folder1.
ii. Click Find.
iii. Type workplan into the Look For field.
e For Outlook 2007:
i. Select Folder1.
ii. Type workplan into the Search Folder1 field.
Forward the third search result to Test2 Tester (replacing the name already there).
Press Send.
Clear the Search results.
Select Folder3.
Arrange the email messages in Folder3 by from: View->Arrange By->From.
Move the Folder3 slider halfway down.
Select an email message, and pause around 2 seconds to read it in the Reading Pane.
Read the next five messages in the Reading Pane by moving to each in succession using the down
arrow, and pausing at each for around 2 seconds each.
Perform an incremental synchronization of 10 email messages:
a. Click the Connected to Microsoft Exchange status message in the lower right corner of Outlook.
b. Select Work offline.
c. Send 10 messages to Test Tester from a third system.
d. Click the Offline status message, and deselect Work offline.
Search for a message (thousands of results - All Mail):
e For Outlook 2003:
i. Select Search All Mail Folders.
ii. Type Workplan into the Look For field.
e For Outlook 2007:
i. Click the drop-down menu in the Search Inbox field of Windows Desktop Search 4.0,
located in the upper-right corner of the message list.
ii. Select Search All Mail Items.
iii. Type Workplan into the Search All Mail ltems field.

. Forward the third search result to Test2 Tester (replacing the name already there).

. Press Send.

. Clear the Search results.

. Select the inbox.

. Read the first five unread email messages in the Reading Pane by selecting each in succession using the

mouse, and pausing at each for around 2 seconds each.

. Mark the first two of these messages for follow-up:

e For Outlook 2003:
i. Right-click both messages, and select Follow Up.
ii. Selectthe red flag.
e For Outlook 2007:
i. Right-click both messages, and select Follow Up.
ii. Select Tomorrow.
Select the next three messages, and move them to Folder 3 by dragging and dropping them.
Select the next email message.
Click Reply to create a reply to the currently open email.
Type Thanks in the body of the message, and press Send.
Close Outlook by clicking the red X in the upper-right corner.
Stop the timer.
Stop the trace by typing xperf .exe -stop in the command prompt window.
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90. Reset the server with the Outlook 2007 SP1 250MB test image and the system with the base Outlook
2007 SP1 image, and repeat steps 2 through 75.

91. Reset the server with the Outlook 2007 SP2 250MB image and the system with the base Outlook 2007
SP2 image, and repeat steps 2 through 75.

92. Reset the server with the Outlook 2003 SP3 5GB test image and the system with the base Outlook 2003
SP3 image, and repeat steps 2 through 75.

93. Reset the server with the Outlook 2007 SP1 5GB image and the system with the base Outlook 2007 SP1
image, and repeat steps 2 through 75.

94. Reset the server with the Outlook 2007 SP2 5GB test image and the system with the base Outlook 2007
SP2 image, and repeat steps 2 through 75.
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Appendix A—Test system configurations

Figure 28 provides detailed configuration information about each of the desktop and notebooks systems we used
to conduct our tests of Outlook. Figure 29 provides detailed configuration information about the Exchange server
we used.

Dell OptiPlex 755 Lenovo ThinkPad T61
System Intel Core 2 Duo E4500 Intel Core 2 Duo T7100
2.20 GHz
General
Processor and OS kernel:
(physical, core, logical)/(UP, MP) 1P2C2L/MP 1P2C2L/MP
Number of physical processors 1 1
Single/Dual/Quad-Core Dual Dual
processors
gﬁ:;m Power Management Balanced Energy Star
p . . Enhanced Intel SpeedStep Enhanced Intel SpeedStep
rocessor power-saving option Technol Technol
echnology echnology

System dimensions (length x » » »
W?’dthxheight) (leng NA 13 1/4” x 10 1/2" x 1 1/4
System weight NA 51bs. 7 oz.
CPU
Vendor Intel Intel
Name Core 2 Duo Core 2 Duo
Model number E4500 T7100
Stepping D D
Socket type and number of pins Socket LGA775 Socket P
Core frequency (GHz) 2.20 1.8
Front-side bus frequency (MHz) 800 800
L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 2 MB 2 MB (shared)
Platform
Motherboard model number 0PU052 7658CTO
Motherboard chipset Intel Q35 Intel GM965
Motherboard revision number A2 Co
System/motherboard serial CN744318203DBF L3-D5889
number
BIOS name and version Dell A12 7LETC5WW(2.25)
BIOS settings Default Default
Memory module(s)
Vendor and model number 2 x 1,024 MB Hyundai Electronics 2 x 1,024 Samsung M470T2953EZ3-

HYMP112U64CP8-Y5 CE6
Type PC2-5300 PC2-5300
Speed (MHz) 667 667
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Dell OptiPlex 755

Lenovo ThinkPad T61

System Intel Core 2 Duo E4500 Intel Core 2 Duo T7100
2.20 GHz 1.8 GHz

Speed running in the system

(MHz) 667 333

Timing/latency (tCL-tRCD-tRP-

tRASMIN) 5-5-5-15 5-5-5-15

Size (MB) 2,048 2,048

Number of memory module(s) 2 x 1,024 MB 2 x 1,024 MB

g:lz‘f)l‘;r_gsf‘d”éfj‘;‘“on (single-sided, | g1 016 sided Double-sided

Channel (single/dual) Dual Dual

Hard disk

Vendor and model number WDC WD800JD-75MSA3 Hitachi HTS541680J9A00

Size (GB) 80 80

Buffer Size (MB) 8 8

RPM 7,200 5,400

Type SATA 3.0 Gb/s SATA 1.5 Gb/s

Controller Intel ICH9 Intel ICH8-M

Driver Intel 8.3.0.1008 Intel 8.2.0.1011

Operating system

Name Windows Vista Enterprise SP1 Windows Vista Enterprise SP1

Build number 6.1.6001 6.1.6001

File system NTFS NTFS

Kernel ACPIx86-based PC ACPIx86-based PC

Language English English

Microsoft DirectX version DirectX 10 DirectX 10

Graphics

Vendor and model number Intel GMA 3100 Intel GMA X3100

Type Integrated Integrated

Chipset Intel Q35 Express Chipset Family Intel 965 Express Chipset Family

BIOS version 1459 1436

II\?S)l available graphics memory 287 358

Dedicated video memory (MB) 0 0

System video memory (MB) 128 128

Shared system memory (MB) 159 230

Resolution 1,280 x 1,024 1,280 x 800

Driver

Intel 7.15.10.1472 (4/18/2008)

Intel 7.14.10.1437

Sound card/subsystem

Vendor and model number

SoundMAX Integrated Digital HD
Audio

SoundMAX Integrated Digital HD
Audio

Driver

AnalogDevices 6.10.1.5491
(8/3/2007)

Analog Devices 6.10.1.5510

Ethernet

Vendor and model number

Intel 82566DM-2 Gigabit Network
Connection

Intel 82566MM Gigabit

Driver

Microsoft 9.11.5.7 (6/21/2006

Intel 9.7.255.0 (3/5/2008)

Wireless

Vendor and model number

| NA

Intel PRO/Wireless 3945ABG

Principled Technologies, Inc.: Responsiveness of Outlook 2007 SP2 vs. previous Outlook versions

34



Dell OptiPlex 755

Lenovo ThinkPad T61

System Intel Core 2 Duo E4500 Intel Core 2 Duo T7100
2.20 GHz 1.8 GHz

Driver NA Intel 11.5.0.36

Optical drive(s)

Vendor and model number Sony CRX880A Matshita UJDA775

Type CD-RW/DVD-RW DVD-ROM/CD-RW

USB ports

Number 8 3

Type 2.0 2.0

IEEE 1394 ports

Number | 0 | 1

Monitor/Display

Type ViewSonic Optiquest Q7b WXGA

Screen size (inches) 17 14.1

Refresh rate (Hz) 60 60

Battery

Type NA 4275229 Lithium lon

Size (length x width x height) NA 8 3/4” x 2 3/4” x 3/4”

Rated capacity NA 5200mAh/10.8V (56Wh)

Weight NA 13 oz.

Figure 28: Detailed system configuration information for the two test systems.
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Server HP ProLiant DL320 1U Rack Server G3
General

'\P/Irs;:essor and OS kernel: (physical, core, logical)/(UP, 1P1C2L/MP
Number of physical processors 1

Single/Dual-Core processors Single

System Power Management Policy Balanced

CPU

Vendor Intel

Name Intel Pentium 4 650
Stepping 3

Socket type 775 LGA

Core frequency (GHz) 3.4

Front-side bus frequency (MHz) 800

L1 cache 16 KB + 12 Kuops
L2 cache (MB) 2

Platform

Vendor HP

Motherboard model number 374295-405
Motherboard chipset Intel E7221 Chipset
Motherboard revision number A03

Motherboard serial number USEG17N1VL
BIOS name and version HP D18 (08/16/2005)
BIOS settings Default

Memory module(s)

Vendor and model number

Micron MT18VDDT12872AG-40BD1

Type PC3200

Speed (MHz) 400

Speed in the system currently running @ (MHz) 200
Timing/latency (tCL-tRCD-iRP-tRASmin) 3-3-3-8

Size (MB) 2,048

Number of RAM modules 2

Chip organization Double-sided
Channel Single

Hard disk

Vendor and model number Maxtor 6L160MO
Number of disks in system 2

Size (GB) 160

Buffer size (MB) 8

RPM 7,200

Type SATA

Controller Intel 82801FB Ultra ATA Storage

Controller driver

Microsoft 6.0.6001.18000 (06/21/2006)

Operating system

Name

Microsoft Windows Server 2008 Enterprise without

Hyper-V x64
Build number 6001
Service Pack SP1
File system NTFS
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Server HP ProLiant DL320 1U Rack Server G3
Kernel ACPI x64-based PC

Language English

Microsoft DirectX version 10

Graphics

Vendor and model number ATl MACH64

BIOS version 01.00

Type Integrated

Memory size 8 MB shared

Resolution 800 x 600

Driver Microsoft 6.0.6001.18000 (06/21/2006)

Network card/subsystem

Vendor and model number

Broadcom NetXtreme Gigabit Ethernet

Type Integrated

Driver Microsoft 10.10.0.1 (08/01/2006)
Optical drive

Vendor and model number Teac DW-224E-C

Type DVD-ROM/CD-RW

USB ports

Number 3

Type 2.0

Figure 29: Detailed system information for the Exchange server.
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Appendix B — Detailed results
Figure 30 presents the average systems response times, in hours:minutes:seconds, to complete email tasks for
the three Outlook versions with 250MB and 5GB mailboxes.

Average system response time

Test 250MB mailbox 5GB mailbox
Outlook Outlook Outlook Outlook Outlook Outlook
2003 SP3 | 2007 SP1 | 2007 SP2 | 2003SP3 | 2007 SP1 | 2007 SP2
Launch Outlook with Task View or | 4.55.01 01 | 00:00:03.54 | 00:00:01.69 | 00:00:01.23 | 00:00:04.04 | 00:00:01.60
To-Do Bar off
Launch reply to email while 00:00:00.74 | 00:00:00.99 | 00:00:00.69 | 00:00:00.57 | 00:00:00.43 | 00:00:00.43
synchronizing
Launch reply to email after 00:00:00.57 | 00:00:00.56 | 00:00:00.51 | 00:00:00.44 | 00:00:00.51 | 00:00:00.35
synchronization is complete
Launch new email while 00:00:00.64 | 00:00:00.71 | 00:00:00.56 | 00:00:00.55 | 00:00:00.39 | 00:00:00.37
synchronizing
Launch new email after 00:00:00.47 | 00:00:00.51 | 00:00:00.46 | 00:00:00.39 | 00:00:00.39 | 00:00:00.28
synchronization is complete
Launch new meeting request 00:00:00.42 | 00:00:00.50 | 00:00:00.44 | 00:00:00.49 | 00:00:00.50 | 00:00:00.46
Switch folder to Conversation 00:00:00.36 | 00:00:00.35 | 00:00:00.34 | 00:00:00.58 | 00:00:00.39 | 00:00:00.41
arrangement
Switch folder to Date arrangement | 00:00:00.28 | 00:00:00.34 | 00:00:00.32 | 00:00:00.27 | 00:00:00.35 | 00:00:00.26
Switch folder to From 00:00:00.31 | 00:00:00.33 | 00:00:00.32 | 00:00:00.25 | 00:00:00.31 | 00:00:00.21
arrangement
Suliel ipideir e Calandaly 00:00:00.37 | 00:00:00.37 | 00:00:00.39 | 00:00:00.28 | 00:00:00.38 | 00:00:00.30
arrangement
Sc')‘;f; ;féer synchronization is 00:00:01.41 | 00:00:01.37 | 00:00:01.35 | 00:00:01.49 | 00:00:02.47 | 00:00:01.96
Launch Outlook with Task View or | .64.00 85 | 00:00:03.73 | 00:00:01.81 | 00:00:01.22 | 00:00:04.59 | 00:00:02.65
To-Do Bar on
Synchronization time for new OST | ).55.06 76 | 00:01:35.03 | 00:01:21.92 | 00:41:02.40 | 00:44:36.27 | 00:29:35.79
to completely download
Search for a message (200 orless | .00.04 59 | 00:00:00.84 | 00:00:00.84 | 00:00:30.58 | 00:00:01.25 | 00:00:00.89
- single folder)
Search for a message (thousands | .44.03 78 | 00:00:00.80 | 00:00:00.83 | 00:00:29.63 | 00:00:00.90 | 00:00:00.92
of results - single folder)
Search for a message (thousands | ,.40.05 59 | 00:00:00.84 | 00:00:03.02 | 00:04:53.48 | 00:00:01.04 | 00:00:04.36
of results - All Mail ltems)

Figure 30: Average system response time, in hours:minutes:seconds, to complete a variety of email tasks for three Outlook
versions with two mailbox sizes. Smaller numbers, reflecting quicker response times, are better.

Figure 31 presents the average number of disk writes during synchronization for the three Outlook versions with

250MB and 5GB mailboxes.

250MB mailbox 5GB mailbox
Outlook Outlook Outlook Outlook Outlook Outlook
2003 SP3 2007 SP1 2007 SP2 2003 SP3 2007 SP1 2007 SP2
Average number of disk writes 6,233.80 756.30 268.30 | 164,148.00 | 454690 | 4759.90
during synchronization
Figure 31: Average number of disk writes during synchronization. Smaller numbers are better.
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Figure 33 presents the response times for a series of 79 common tasks from a typical workday for the three
Outlook versions with 250MB and 5GB mailboxes.

250MB mailbox 5GB mailbox

Outlook Outlook Outlook Outlook Outlook Outlook

2003 SP3 2007 SP1 2007 SP2 2003 SP3 2007 SP1 2007 SP2
Step 1: Launch Outiook and 00:02:47.77 | 00:02:19.46 | 00:01:39.60 | 01:12:40.17 | 00:51:06.00 | 00:38:35.66
sync mailbox
Sllpps T el e @) 00:20:07.52 | 00:15:30.49 | 00:13:06.53 | 00:20:30.04 | 00:13:04.58 | 00:10:56.44
workflow
Total 00:22:55.30 | 00:17:49.95 | 00:14:46.13 | 01:33:10.20 | 01:04:10.58 | 00:49:32.10
Figure 33: Response times for a series of 79 common tasks from a typical workday. Smaller numbers are better.
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About Principled Technologies

We provide industry-leading technology assessment services. We bring to every assignment extensive
experience with and expertise in all aspects of technology testing and analysis, from research into new
technologies, to the development of new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We

provide our clients with the materials they need, from market-focused data to use in their own collateral to custom
sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results
of our trusted independent analysis.

We provide customized services that focus on our clients’ individual needs. Whether the technology involves
hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help you assess how
it will fare against its competition, its performance, whether it's ready to go to market, and its quality and reliability.

Our founders, Mark Van Name and Bill Catchings, have worked together in technology assessment for over 20
years. As journalists, they published over a thousand articles on a wide array of technology subjects. They
created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff
Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that
company by Lionbridge Technologies were the head and CTO, respectively, of VeriTest.
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